
Using the Mackie Control with Cool Edit Pro 2.1 
 
 
The Cool Edit Pro 2.1 update adds support for the Mackie Control surface controller 
device. Please note that you must have installed the 2.1 (or later) update, since this device 
is not supported in Cool Edit Pro version 2.0. To see which version of Cool Edit Pro you 
are currently running, open your Cool Edit Pro and go to Help-About Cool Edit Pro. In the 
window that opens you should see the version number. If you have version 2.0, then it is 
necessary that you go to the download page of the Syntrillium web site and download the 
latest update and install it following the instructions provided.  
 
http://www.syntrillium.com/cep/ 
 
 

SETUP 
 
There is no additional software required for Cool Edit Pro to access the Mackie Control 
unit. This unit needs to be connected to a MIDI In and Out port on your PC, and Cool Edit 
Pro 2 needs to be set to detect the device on the MIDI port. Most PC sound cards offer an 
included MIDI hardware In and Out port. If not, there are many options for MIDI port 
devices available from most any music equipment retailer. For more information on MIDI 
connection options for the Mackie, please be sure to consult your Mackie documentation. 
To follow are configuration settings for selecting the Mackie Control and MIDI port within 
Cool Edit Pro 2. Close Cool Edit Pro and then follow these steps: 
  
STEP 1 - Connect the MIDI Out from the Mackie Control to the MIDI In port connector for 
your PC using a standard MIDI 5-pin cable.  
 
- Connect the Mackie’s MIDI In to the MIDI Out port from your PC. 
 

 
 

*NOTE: It is necessary that you connect the Mackie Control’s MIDI In and Out directly to your PC 
MIDI ports. It is not recommended that you connect other MIDI devices into the MIDI signal chain 
(a.k.a. “daisy-chaining” the Mackie along with other MIDI hardware devices) to share a MIDI port. 
 



 
 
STEP 2 - Turn on the Power for the Mackie unit – the Mackie must be powered on before 
launching Cool Edit Pro in order for the software to detect it. 
 
 
STEP 3 - Launch Cool Edit Pro and go to the Options > Device Order > Ext. Controllers 
tab window. Select Mackie Control from the drop-down menu field titled “External Control 
Device”.   
 
 
 

 
 
 
 
 
STEP 4 – Click on the “Configure…” button to launch the “Configure Mackie Control” 
dialog. Here you need to select the MIDI In and Out Devices from the respective lists. You 
will want to select the ports that you connected your Mackie Control unit into in step 1. 
Leave the “Mackie Switch” field blank for now – you can use this option later if you wish to 
customize some of the user-configurable buttons on the Mackie unit. Click “OK” to close 
this window. If you do not click OK before closing this Configure dialog, your settings will 
not be retained.  



 
 
 

NOTE: If your MIDI port device does not appear in the MIDI Input Device or MIDI 
Output Device lists, then Windows has not detected or installed the MIDI Port 
device correctly and you should refer to the MIDI hardware’s documentation for 
proper installation steps.  

 
 
STEP 5 – Click OK on the Ext Controllers dialog to close it. If you do not click OK before 
closing this dialog, your settings will not be retained.  
 
STEP 6 – Go to File > Exit and close Cool Edit Pro. Then, with the Mackie Control device 
still powered on, re-launch Cool Edit again. This may be necessary to establish the 
connection to the Mackie Control. Your Mackie Control should now be properly configured 
and ready to use with Cool Edit Pro. You should not need to repeat these steps since the 
Mackie Control should retain these settings unless you decide to change them.  
 
 
 
The ”Update text display in real-time” checkbox is offered in case your MIDI port device 
has trouble communicating data back to the Mackie LED display. It is recommended that 
you keep this box checked (the default state). But if you encounter issues where the 
numerical values on the Mackie LED display are not updating fast enough while moving 
faders or V-Pots, or if the MIDI port stops responding, then you may try un-checking this 
box. This reduces the update of the display and may resolve these types of issues. 
 
If you wish to plug your Mackie Control into a different MIDI port at a later time, you can 
then use the “Configure…” button in the Ext. Controller window to access the new MIDI 
device settings. To manually reset the Mackie to a MIDI port repeat the steps above. 



 
 
Customizing the Mackie Switches 
Cool Edit Pro already includes a preset “Profile” for the Mackie Control. This is a set of 
commonly accessed functions mapped to the Mackie unit’s faders, V-pot rotary knobs and 
push button controls.  This profile is automatically loaded once you have the Mackie 
Control active with Cool Edit Pro. Cool Edit Pro also offers customization for many of the 
Mackie push-button switches. Within Cool Edit Pro’s Configure dialog you can change the 
Cool Edit Pro command that is assigned any of the Mackie switches in the menu of the 
“Mackie Switch” field. Just select the desired Mackie push-button switch from this menu 
and then click on the “Cool Edit Commands” drop-down menu and select the Cool Edit Pro 
2 command from the list that you wish to map to the selected push-button switch. Repeat 
this step for each Mackie switch you wish to customize, then click OK to exit the Configure 
dialog and retain your changes. 
  
 
Reset to Default Profile 
Since Cool Edit Pro allows you to customize the commands of many of the Mackie’s 
buttons, Cool Edit Pro also offers a “Reset” switch to allow you to set these buttons all 
back to their original Cool Edit Pro/Mackie Profile settings. This will discard any custom 
button settings you may have set up. The “Reset  to Defaults” switch is located in Cool Edit 
Pro 2’s Options > Device Properties > Ext Controllers > Configure button dialog for the 
Mackie controller. Click on this reset button when the Mackie is active to reset the unit to 
default Profile settings. 
 

 
 
 
 
The Cool Edit Pro Layout Overlay 
The Mackie Control offers interchangeable plastic “Overlay” template sheets to allow you 
to have software-specific labels for push buttons on the right portion of the controller unit. 
(Shown on the last page of this document.)  You may have received a Cool Edit Pro 
Overlay in the box with your Mackie Control unit. If not, then please contact Mackie or 
Mackie hardware dealer to receive a Cool Edit Pro Overlay and consult the Mackie 
documentation for the instructions on affixing the Overlay sheet. The Cool Edit Pro Overlay 
offers its own descriptive text labels for the many buttons on the right side of the Mackie 
surface. In this document we will refer to button names as those provided on the Cool Edit 
Pro overlay. 
 



The Cool Edit Pro 2 Mackie Profile  
 
 
Commands List 
Cool Edit Pro already includes a preset “Profile” for the Mackie Control. This is a set of 
commonly accessed functions mapped to the Mackie unit’s faders, V-pot rotary knobs and 
push button controls.  To follow are descriptions of these Profile commands.  You can 
further customize several Mackie Switches in the Ext. Controllers dialog – refer to the 
previous “Customizing the Mackie Switches” section for details. 
 
 
 
Assigning Channel Strips to Cool Edit Pro Tracks 
To set up the Mackie Control’s channel faders and switches for your Cool Edit Pro session, 
it is first necessary to learn how to assign the Mackie’s 8 channel strips to the desired Cool 
Edit Pro tracks. This is achieved using the 6 buttons in the FADER BANKS section. 
 
 

 
 

FADER BANKS buttons 
 
BANK < > = these left and right arrow buttons are used to assign the Mackie channel 
faders to the previous/next set of 8 Cool Edit Pro tracks. For example, upon starting a Cool 
Edit Pro new session, the 8 Mackie channel strips are assigned to control Cool Edit Pro 
tracks 1 – 8 respectively. However, if you click on the BANK right arrow button once, the 
Mackie channel strips will then control track 9 – 16, and you can assign the channel strips 
to successive banks all the way up to tracks 121 - 128. 

 
CHANNEL < > = these left and right arrow buttons re-set the Bank set to include a 
different set of tracks. For example, by default the 8 Mackie channel strips are assigned to 
banks in the order of tracks 1 – 8, 9 – 16, 17 – 24, etc. By using these Channel < >  
buttons it is possible to reconfigure the Bank sets to tracks 2 – 9, 10 – 17, 18 – 24, etc. 
Hitting one of the Channel arrow buttons should ascend/descend the bank groups by one 
track per click.  
 

 



The FLIP and EDIT buttons located just above the Master fader offer more control over 
channel strips: 
 
FLIP button = this button “resets” the channel strip assignment to Cool Edit Pro tracks 1 – 
8, so that you can easily reset the Mackie back to this first set of tracks.  

 
EDIT button = this button instantly sets the 8 channel strips to Cool Edit Pro tracks 121 – 
128.  

 
 
 
 
Channel Strip Controls 
Each of the Mackie’s 8 channel strips has the following common buttons. These are only 
active in Cool Edit Pro’s Multitrack View.  
 
By default, the Mackie Control will initialize and be set in the MIX mode, where the LCD 
display at the top of the unit shows the currently selected track’s number, text title and its 
Track Volume setting. The bottom row of this display indicates the current track number 
assignment for each Mackie channel strip. For example, once Cool Edit Pro is launched 
and set to the Multitrack View, the Mackie LCD display would look similar to this: 
 
 
 
 
 

V-POTS & ASSIGMENT buttons 
 
 
 
 

 
V-POTS 

 

009 Track 9       Vol –3.4dB 
 9   10    11     12      13      14      15      16 



 
 

ASSIGNMENT Buttons 
 
 

• The rotary knob at the top of each channel strip is referred to as a V-Pot. Each V-
Pot is a multi-function control knob and has different uses for Cool Edit Pro 
depending on the current “mode” assignment.  

 
• The V-Pot functions are governed by the buttons to the right in the ASSIGNMENT 

section. Cool Edit Pro allows you to switch into two optional modes – PAN or EQ – 
by selecting one of these two buttons.  The current mode selection is indicated by 
the LED light next to the respective ASSIGNMENT button. De-selecting either the 
PAN or EQ assignment buttons always returns you to the default MIX mode.  

 
• Each V-Pot knob also includes a switch (press down on the rotary knob itself). This 

knob switch can also is also assigned as listed below… 
 
PAN Assignment button – this button places the V-Pots in PAN mode. When engaged, this 
button’s LED illuminates and all V-Pots will pan the currently selected track output left or 
right. While in Pan mode you will also see that the main Mackie display (above the channel 
strips) shows you your currently selected track’s Pan settings. To exit Pan mode simply 
press the PAN assignment button again so that its LED light is no longer lit. This will return 
the unit to MIX mode where the LCD display also returns to showing the track volume 
settings. (See the Display section in this document for more details). While in PAN mode, 
the V-Pot knob push switch has no function.  

 
EQ Assignment button – this button allows you to toggle in and out of EQ mode, which 
allows the V-Pots to control Cool Edit Pro’s dedicated Track EQ for the selected track.  
The EQ button’s LED illuminates when EQ mode is engaged. Pressing the EQ button 
again disengages the EQ mode and returns the unit to MIX mode. When EQ mode is 
engaged, the selected track’s V-Pot knob push switch cycles through the Hi, Med and Low 
EQ Gain value parameters. Turning the V-Pot should then adjust the active parameter 
up/down. When in EQ mode, the LCD display will show the Track EQ settings as you 
make them for the selected track. (See the Display section in this document for more 
details). 
 

Note - The other 4 ASSIGNMENT buttons have no related function within Cool Edit Pro.  



 
 

Channel Strip Buttons – these buttons are common to each channel strip and will act 
upon the currently assigned track. 
 

 
 
REC/RDY Button  

      
• Toggles Cool Edit Pro’s Track Record Arm button. The red light on this 

button illuminates when the track is armed for recording.  
 

 
 
SOLO Button 

 
 
 

• Toggles Cool Edit Pro’s Track Solo function. This button illuminates when 
Solo is active.  

 
 

 
MUTE Button 

      
 

• Toggles Cool Edit Pro’s Track Mute function.  This button illuminates when 
Mute is active.  

 
 

 
SELECT Button 

 
 

• Shifts the focus and selects this track. The button will illuminate to indicate 
which channel is currently selected.  

 
• It is only possible to select one channel/track at a time.  

 
 



• Any channel becomes selected by either pressing this SELECT button, or 
also by pressing the channel’s REC/RDY, SOLO, or MUTE buttons. You will 
see the selected track in Cool Edit Pro is then shaded a lighter color for both 
the Multitrack Track itself, and in the Cool Edit Pro Mixer panel. 

 
• Once you push the Mackie Select button on any channel strip, this channel 

stays selected until another channel is selected. Therefore, if you select a 
channel and then press the BANK switch to assign the 8 Channel Faders to 
a different set of Cool Edit Pro tracks, you should note that the currently 
Selected channel is still the one in the previous Bank. 

 
• The Mackie channel faders are also touch-sensitive, therefore, simply 

touching any fader knob will allow you to still access the assigned Cool Edit 
Pro track volume, even though it does not ‘select’ the track. 

 
• The Signal LED light in each channel strip is not utilized by Cool Edit Pro  

 
 
Channel Faders  
 

       
 

• The 8 channel faders and 1 master fader allow control of Cool Edit Pro’s track 
volumes and master volume. The channel faders default as assigned to track 1 – 8 
on opening a new session. The 8 channel faders can be assigned to and switched 
between different sets of 8 tracks easily by using the FADER BANKS switches 
located above the Master Fader.   

 
• The channel faders on the Mackie are motorized and they will update to reflect Cool 

Edit Pro’s Multitrack Mixer’s fader settings. It is not necessary to “Null” the Mackie 
faders – when you switch to a different Bank these motorized faders will move to 
reflect the new 8 Cool Edit Pro track volume settings.  

 
• Likewise, moving any Cool Edit Pro Multitrack Mixer fader with the mouse also 

moves the Mackie motorized fader that is assigned to this track.  Again, you will 



only be able to see the Mackie channel fader move if the Mackie Bank is currently 
set to one of the 8 Cool Edit Pro tracks you happen to be accessing with the mouse.  

 
 
NOTE: The following sections of buttons can be covered with the optional plastic Overlay. 
Once installed, the Cool Edit Pro overlay provides the following text labels. 
 
 
 
UNDO = At the top left of this section is the Undo button.  This ‘undoes’ the last performed 
command. 
REDO = The button re-applies the last command that was ‘undone” using the Undo 
command 

 
 
EDIT VIEW COMMANDS  
 
The 8 buttons in this row currently each have an assigned Cool Edit Pro Profile function by 
default and this list is as follows. These 8 functions are ones that are used in the Cool Edit 
Pro Edit View only.  These 8 buttons are also  “User Configurable” – that is, you can re-
map these buttons to any Cool Edit Pro command within the Ext Controllers-Configure 
button dialog. Please refer to the preceding  “Customizing the Mackie Switches” section for 
details.  
 
COPY = Copy current selection 
CUT = Cut current selection  
PASTE = Paste at current cursor location 
TRIM = Deletes all but the selected area of the current file 
FREQ = Toggles the Frequency Analysis window open/closed 
PHASE = Toggles the Phase Analysis window open/closed 
SPECTRAL = Toggles the Cool Edit Pro Edit View display between Waveform/Spectral  
INSERT = Inserts the current file or selection from Edit View into the next available track in 
the Multitrack. 
 
 
GLOBAL COMMANDS BUTTONS  
The 8 buttons in this row currently each have an assigned Cool Edit Pro Profile function by 
default and this list is as follows. These 8 functions are ones that function in both Cool Edit 
Pro’s Edit and Multitrack Views. These 8 buttons are also  “User Configurable” – that is, 
you can re-map these buttons to any Cool Edit Pro command within the Ext Controllers-
Configure button dialog. Please refer to the preceding  “Customizing the Mackie Switches” 
section for details.  
 
VIEW = Toggles the Cool Edit Pro display between Edit and Multitrack Views  
MON.REC. = Toggles Cool Edit Pro into ‘Record Monitor” mode to allow you to check your 
input levels   



CUE = Adds current cursor location or selection to Cue List  
CUE LIST = Toggles the Cue List open/closed 
SEL. ALL = Selects all data in the current view – in Edit View this highlights the entire 
length of the file. In Multitrack this selects all blocks.  
ZOOM FULL = Zooms the current view out vertically and horizontally to show the entire 
length of the file or session 
CLOSE = Closes the current File or Session  
SAVE = Saves the current File or Session 
 
   
 
SHOW/HIDE buttons 
These 4 buttons allow you to show or hide the respective dockable windows. These four 
button assignments are: 
 
MIXER = Show/hide the Multitrack Mixer window 
 
SES. PROP. = Show/hide the Session Properties window 
 
EQ = Show/Hide the currently selected track’s EQ window. This is handy to toggle the EQ 
window open or closed when also using the Mackie V-Pots in EQ mode to access the 
Track EQ parameters. 
 
ORGANIZER = show/hide the File Organizer window in either Edit or Multitrack View. 
 
 
MULTITRACK FUNCTIONS Buttons   
The 10 buttons in this section are assigned to specific Multitrack View Cool Edit Pro 
actions as described below.  
 
NEXT = Selects the next block in the currently selected track so that a function can be 
applied to the block (such as Nudge, Split, Remove, etc.) 
 
SPLIT Splits the currently selected block into two blocks at the cursor location 
 
TRIGGER = Toggles Cool Edit Pro’s MIDI Trigger option on/off 

 
SMPTE S = Toggles the SMPTE Slave option on/off 

 
SMPTE M = Toggles the SMPTE Master option on/off 
 
REMOVE = Removes the currently selected block from the session 
 
METRONOME = Toggles the Metronome on/off 
 
< CURSOR = Resets the cursor back to the 00:00 time position.  

 
< NUDGE = Nudges the currently selected block Left  

 



NUDGE > = Nudges the currently selected block Right  
 

 
 
TRANSPORT CONTROLS 
 

 
 
The ‘tape deck style” transport buttons, as expected, will shuttle Cool Edit Pro’s REWIND, 
FAST FORWARD, STOP, PLAY, & RECORD functions.  The LED for each button will 
illuminate when the action is engaged. These transport buttons function in both Cool Edit 
Pro’s Edit and Multitrack Views as well.  There are also a few other commands available 
using these Transport buttons: 
 

• Double-tap the << REW button to place the cursor and view at the start of the Cool 
Edit Pro session (MT), file (EV) or to next Cue marker to the left (MT and EV). 

 
• Double-tap the >> FF button to place the cursor and view to the end of the session 

(MT), file (EV) or next right Cue marker (MT and EV) 
 

• Once you are in playback mode, PAUSE is available if you press the PLAY > button 
once during playback (MT and EV). To resume playback, press the PLAY > button 
again. 

 
• Once you are in record mode, PAUSE is available if you press the RECORD button 

once during playback (MT and EV). To resume record, press the RECORD again. 
 
 
 
TRANSPORT FUNCTIONS 
 
In addition, the row of push buttons just above the Transport can also be used to modify 
the behavior of the Transport.  The left three buttons offer the 3 Cool Edit Pro transport 
Play modes and only one can be active at a time. Therefore you will note that as you 
select any one of these 3 buttons, it will automatically de-select the previously active play 
mode. The green LED glows to indicate the active button. These Play mode selectors 
make the Mackie Transport Play button duplicate the Cool Edit Pro play button mode. This 
means that you can still also right click your mouse on the Cool Edit Pro transport buttons 
to select exactly which play behavior you want for each of these respective play modes, 
and the Mackie transport Play button will simply trigger it. 
  

 = Duplicates the behavior of the Cool Edit Pro Transport standard Play button 
(the right arrow Play button). 

 



 = Duplicates the behavior for the Cool Edit Pro “Play to End” transport Play 
button. 
 

 = Duplicates the Cool Edit Pro Transport “Loop Play” button. 
 
PUNCH IN = When engaged places Cool Edit Pro’s Multitrack into Punch In recording 
mode. You must first select a waveblock in a track and highlight the desired selection of 
the block to initiate Punch In mode. To disengage punch In mode, simply disarm the REC 
button for the Punch In enabled track(s).  
  
ANCHOR L  = Anchors the cursor during playback. Press this while Cool Edit Pro is 
playing to change the cursor location to the current time position. 
 
ANCHOR R = Anchors a 2nd, Right cursor position during playback. Press this while Cool 
Edit Pro is playing to create a highlighted selection from the existing anchored cursor 
position to the current time position  
 
DISABLE = disables recording altogether in Cool Edit Pro so that pressing the Record 
transport button does nothing. The red LED will illuminate to indicate when record is 
disabled. 
 
 
 
JOG WHEEL 
 

 
 
 
The Jog Wheel shuttles the cursor left or right in time across the waveform in Edit View, or 
the Session display in Multitrack View. Since Cool Edit starts playback from the cursor 
position, this is a handy way to move your playback start position easily.  
 
 
 
 



ARROW - ZOOM Buttons 
 
 

 
 
 
The 4 Arrow buttons located below the Transport controls offer two “modes” of operation, 
which are accesses by the ZOOM button in the middle of the keys. With the ZOOM button 
de-activated (the red LED not illuminated) the four arrow buttons function as follows: 
 
Left Arrow = Adjust Selection Left Side to Left (Edit View and Multitrack View). This allows 
you to extend a highlighted selection by moving the left edge further to the left. It also 
allows a selection to be created from the cursor (if no selection is currently defined), 
extending to the left. 
 
Right Arrow = Adjust Selection Right Side to Right (Edit View and Multitrack View). This 
allows you to extend a highlighted selection by moving the right edge further to the right. It 
also allows a selection to be created from the cursor (if no selection is currently defined), 
extending to the right. 
 
Up Arrow = Selects the next track up (in the Multitrack View) – and Selects Left Channel 
only of the current file (in the Edit View) 
 
Down Arrow = Selects the next track down (in the Multitrack View) - and Selects the Right 
Channel only of the current file (in the Edit View) 
 
 
When the ZOOM button is active (the LED illuminated), these arrow buttons then function 
as follows (in both Edit and Multitrack Views): 
 
Left Arrow = Zooms out horizontally  
 
Right Arrow = Zooms in horizontally to the current playback cursor position or selection 
 
Up Arrow = Zooms in vertically  
 
Down Arrow = Zooms out vertically 
 
 

Note: The SCRUB button in this section has no current Cool Edit Pro assignment.  
 
  



 
DISPLAY – Left LCD Display 
 
This display above the Channel Controls provides information related to the selected 
track’s Volume, Pan or EQ settings, depending upon the current “Mode” that is selected. 
The bottom row of the display always shows the 8 track numbers for the current bank set, 
which allows you to easily see what Cool Edit Pro track the fader below is currently 
assigned to. Note that if you have typed in a name for your track that top row will display 
your track name text in place of the default  “Track xx”. 
 
The default Mode is “Mix” mode, and alternatively you can select the Pan or EQ 
assignment buttons to switch to Pan or EQ mode (refer to the V-POTS & ASSIGMENT 
buttons section in this document for further details regarding these modes). In Mix mode, 
the top row of this display will show the Volume setting for the currently selected track. To 
follow is an example where Track 9 is the selected track and its volume is set to –3.4 dB: 
 
  
 
 
 
 
 
To follow is an example of the LCD display when in Pan mode, where Track 9 is selected 
and its Pan value is set right 14 %:  
 
 
 
 
 
 
 
To follow is an example of the LCD display when in EQ mode, where track 9 is selected, 
the Track EQ Mid Gain parameter is selected, and its value is set to a +1.3 dB boost. 
 
 
 
 
 
 
 
ASSIGNMENT LED display  
 
The unit offers a 2 character LED display already titled ASSIGNMENT. This display has no 
related function for Cool Edit Pro 2 and therefore will not display any characters. 
 
 
 
TIME POSITION LED DISPLY 
 

009 Track 9       Vol –3.4dB 
 9   10    11     12      13      14      15      16 

009 Track 9      Pan Right  14 
 9   10    11     12      13      14      15      16 

009 Track 9    EQ Gain Mid +1.3dB 
 9   10    11     12      13      14      15      16 



     
 
The red LED numerical display will reflect the Cool Edit Pro Time position. Note that it will 
also reflect the current Cool Edit Pro Time Ruler formatting for any of Cool Edit Pro’s 
options – HMS, BPM, SMPTE fps, Samples, or Custom. This display format will update 
whenever you select any of the Time Ruler options within Cool Edit Pro.   
 
 
One of the two indicator LED lights at the left of the numerical characters in this display will 
show when the format is SMPTE or BPM (“Beats”). If the current Ruler Display format is 
HMS or Samples, then no indicator light will be illuminated. 
 

                                                    
 
 
 
Rude Solo Light = This indicator light is not utilized by Cool Edit Pro and will remain unlit. 
 
 
USER SWITCHES A and B (on the Mackie back panel) 
These two ¼ inch jacks are intended for plugging in a momentary footswitch to trigger the 
assigned software functions. (The remote footswitch units are not supplied with the Mackie 
Control, but can typically be purchased from any musical instrument retailer.) 
 
In Cool Edit Pro these User Switches are  “User Configurable” – that is, you can re-map 
these to any Cool Edit Pro command within the Ext Controllers-Configure button dialog. 
Please refer to the preceding  “Customizing the Mackie Switches” section for details. The 
default functions assignment in Cool Edit Pro for these two jack switches are as follows: 
 
USER SWITCH A = Toggles between Record and Stop (in both EV and MT). 
 
USER SWITCH B = Toggles between Play and Stop (in both EV and MT). 
 
 
 

 



  
 
 
MACKIE EXTENDER UNIT 
In addition to the Mackie Control unit, Mackie also offers the “Extender” unit, which is 
designed to be used in tandem with the main Mackie Control unit, thus adding controller 
support for additional channel control. Cool Edit Pro does not currently support the use of 
an Extender device simultaneously with the main Mackie Control device on the same 
system. 
 
 
 
 
 
For additional support regarding the Mackie Control, please visit:  
 
http://www.mackie.com/record/mackiecontrol/mackiecontrol_support.html  
 
or contact Mackie Designs Tech Support toll-free at 800.258.6883  
(outside the US and Canada call +1 425.487.4333)   
 
 
 



 
 
 
 
 
 
 
--END-- 
 


